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1. Introduction 
MultiMode CATS is a multi link, multi protocol, ADS-B surveillance tool, 
run on Windows platforms. 

 

MultiMode CATS support several ADS-B protocols on several kinds of 
transport links, simultaneously. Is also contains relaying capabilities, 
incoming data can be converted to a different protocol, and re-transmitted 
on outgoing links. 

MultiMode CATS also contains alarms, (e.g. timeouts and obstacle) and 
various filtering functions. 

2. Menu bar 

2.1 File menu 

The File menu contains menu choices for defining input and output links of 
MultiMode CATS.  

2.1.1 Open realtime source 

The Open realtime source menu choice brings the following dialog: 
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To open a realtime source, select Data source format, then select transport 
link, i.e. File, Internet (TCP/IP, Internet (UDP/IP) or Serial port. Note 
that some formats may not be supported on all transport links.  

2.1.2 Close realtime source 

The Close real time source menu choice brings up a dialog list with 
active data links. To close a data link, select the link and press the OK or 
Apply button. 
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2.1.3 Open playback source 

To replay previously data source recordings, hereby after called playback 
source, use the Open playback source menu choice. This will bring a File 
dialog for browsing and selecting the replay file. 

 

2.1.4 Close playback source 

Use this menu choice to close a playback source.   

2.1.5 Open output device 

To relay incoming data sources, on output links, use the menu choice Open 
output device. The following dialog will be brought up: 
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Chose output format in the Data device format drop down list. Then select 
transport link type and communication characteristics. 

When an output source is created, a tab form will be inserted in the Map 
View, see section 11 for further details. 

2.1.6 Close output device 

Use the menu choice to close any opened output device. 
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2.1.7 Start recording 

Use this menu choice to create replay files, i.e. saved incoming data. A file 
dialog will be brought up, to let the user specify replay file name and 
location. 

2.1.8 Stop recording 

To stop any ongoing replay recording, use this menu choice. 

2.1.9 Analyze recording 

This menu choice will bring up a File dialog for choosing any previously 
recorded replay file. A temporary spreadsheet file will be created and then 
Excel will be opened on the spreadsheet file. 

2.1.10 Load Flight Plans 

This menu choice will enable user to load any previously stored flight plans 
into MultiMode CATS. A file browser is opened, filtering out files with 
default extension *.fpl.  

2.1.11 Save Flight Plans 

This menu choice will save all flight plans entered into MultiMode CATS. 
A save file browser is opened and flight plans can be stored onto disk, with 
default extension *.fpl.  

2.1.12 Load Polygons 

This menu choice will enable user to load any previously stored polygons 
into MultiMode CATS. A file browser is opened, filtering out files with 
default extension *.ply.  

2.1.13 Save Polygons 

This menu choice will save all polygons entered into MultiMode CATS. A 
save file browser is opened and polygons can be stored onto disk, with 
default extension *.ply.  
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2.1.14 Load Caps Filters 

This menu choice will enable user to load any previously stored Caps filters 
into MultiMode CATS. A file browser is opened, filtering out files with the 
extension *.cap. Please note that all Caps filters in MMCats before load will 
be deleted. 

2.1.15 Save Caps Filters 

This menu choice will save all Caps filters entered into MultiMode CATS. 
A save file browser is opened and the Caps filters can be stored in a file 
with the extension .cap. 

2.1.16 Exit 

The Exit menu choice will close any opened data source as well as any 
output devices and the exit the MultiMode CATS. 

2.2 Edit menu 

2.2.1 Preferences 

The Preferences menu choice enables editing of display and object 
preferences. The following preferences can be edited: 

• Color of world map layers, i.e. land, border, sea or text color. 

• Color and transparency of Caps polygon and circles. 

• Timeout and removal times for map objects, i.e. aircraft, ground 
vehicles and base stations. 

• Length of object prediction line in seconds  

2.2.2 Organize Labels 

The Organize Labels menu choice brings up a form for selecting the 
object label properties in the map view. 

2.2.3 Caps Filters 

This menu choice brings up a tree-hierarchy editor for creating, editing and 
removing CAPS filters. See chapter 12 Caps Filters. 
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2.3 View menu 

The View menu contains choices for toggling tool and display options on 
or off. 

The upper section contains the following options for customize the user 
interface: 

• Main Toolbar (see section 4) 

• View Toolbar (see section 5) 

• Playback Toolbar (see section 6) 

• Playback Slider (see section 7) 

• Status Toolbar (see section 8) 

• Object List (see section 9) 

• Overview Map (see section 10) 

• Output Devices (see section 11) 

The middle section contains the following options for customize the objects 
and labels displayed on the Map View (see section 3): 

• Id  ADS-B identification of map objects 

• Altitude altitude of map objects 

• Speed speed of map objects 

• Prediction Line prediction line of map objects 

• History tracks display object history tracks 

The lower section contains filtering options for object types displayed on 
the Map View: 

• Aircraft 

• Ground Vehicles 

• Base Stations 
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2.4 Tools menu 

The Tools Menu controls the mouse tool in the Map View. Following 
tools are available in the Tools Menu: 

• Zoom In zoom in the Map View 

• Zoom Out zoom out the Map View 

• Zoom Rectangle zoom in selected area in the Map View 

• Center center Map View at mouse cursor 

• Distance measure distance between points on Map View 

• Select select object at mouse cursor 

• Add Obstacle  add obstacle on Map View 

• Create Caps Polygon create a Caps polygon filter 

• Create Caps Circle Sector create a Caps sector filter 

• Create Flight Plan create a flight plan in map view 

• Create Polygon  create a polygon in map view 

• Move map left  pan Map View to the left 

• Move map right  pan Map View to the right 

• Move map up   pan Map View up 

• Move map down   pan Map View down 

• Obstacle Properties edit properties of selected obstacle 

• Remove Obstacle remove selected obstacle 

2.5 Help menu 

This menu choice contains  

• About shows current version of MultiMode CATS 

• License Information administration of license 
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3. Map view 
The Map View displays a map and incoming ADS-B objects from data 
sources. 

 

The Map View holds a context sensitive popup-menu, which is brought up 
by right-clicking the mouse. The popup-menu contains following choices: 

Extended info… Shows an ADS-B report for 
selected object 

Remove distance  Remove selected distance line 

Acknowledge emergency alert Acknowledge incoming STDMA 
emergency alert 

Obstacle properties… Edit selected obstacle properties 

Remove obstacle Remove selected obstacle 

Edit Drawn Object Edit properties of selected polygon 
or flight  plan 

Remove Drawn Object Remove selected polygon or flight 
plan 
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Hide Caps Filter Hides the selected Caps polygon or 
circle. 

Hide and unsubscribe Caps Filter Sends a remove message for the 
selected Caps polygon/circle and 
hides it from the map. 

Hide All Caps Filters Hides all Caps polygons and 
circles. 

Show All Caps Filters Shows any hidden Caps polygons 
and circles. 

 

Left mouse button is bound to current selected tool see section 2.4 for 
information of different mouse tools. 

By selecting an object in the Map View, an object label is displayed. The 
label displays selected ADS-B characteristics. 

4. Main Toolbar 
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The Main Toolbar provides buttons for the most commonly used functions. 
These functions are: 

•  Open realtime source 

•  Open playback source 

•  Open output device 

•  Start recording 

•  Analyze recording 

•  Toggle object identification string on/off 

•  Toggle object altitude on/off 

•  Toggle object speed on/off 

•  Toggle object prediction line on/off 

•  Display aircraft 

•  Display vehicles 

•  Display base stations 

•  Display overview map 
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5. View Toolbar 

The View Toolbar contains map functions as: 

•  Zoom in 

•  Zoom out 

•  Zoom in on selected rectangle 

•  Center map 

•  Distance meter tool 

•  Select tool 

•  Pan map left 

•  Pan map right 

•  Pan map up 

•  Pan map down 

• Zoom scale drop-down list 
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6. Playback Toolbar 

 

The Playback Tool contains controls for replay files, such as: 

•  step backwards in replay 

•  pause replay 

•  play replay 

•  replay forward  

•  replay fast forward 

•  step forward in replay 
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7. Playback Slider 

 

The slider tool enables direct time access into replay file. At the left of the 
slider tool, the recorded start time is displayed. At the right of the slider tool 
actual recorded time of replay is displayed. 
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8. Status Toolbar 

 

The Status Toolbar displays various information messages during 
MultMode CATS sessions. 
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9. Object List 

 

The Object List holds all incoming data source objects, sorted into a tab 
dialog with four different categories. The categories are: 

• Aircraft 

• Ground vehicles 

• Base stations 

• Data sources 

For the three first categories, an alarm warning, displayed as a yellow circle 
in front of the object id, is given, whenever the object times out. Time out 
limits are set in the Preferences dialog, see also 2.2.1. 

By selecting an object and then right click the mouse button, a popup-menu 
is opened. The popup contains the following menu choices: 

• Extended info… 

• Acknowledge emergency alert 
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Extended info… will show a form containing all ADS-B information for 
selected object. 

Acknowledge emergency alert acknowledges any emergency alert sent 
from selected STDMA object. 

By clicking on an object, the object will be selected in the Map View, and 
the object label will be displayed. 

By double-clicking on an object, the Map View will be centered by the 
object position.  

10. Overview Map 

 

The Overview Map gives an overview of surrounding geographic areas. 
The square indicates the borders of the Map View. The Overview Map also 
contains map interactions as panning and zooming, by moving and resizing 
the square.  
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11. Output Devices 

 

Whenever an output device is opened, the Output Devices tab dialog is 
displayed.  The tab dialog holds one tab for each output device. The dialog 
enables start and stop of the relayed data stream, as well as various real-
time modifications of the data stream, depending on the data format. 
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12. Caps Filters 

 

The Caps Filter dialog is used for editing the Caps filters and to start and 
end caps filter subscriptions. 

12.1 Send Subscribe/Send Remove 

Clicking these buttons will cause a Subscribe/Remove message to be sent 
on any open Caps real-time data source. This will update the status of the 
selected filter. The following values are possible: 

Status Description 

Created Filter is created and no subscribe message has 
been sent for filter. 

Subscribing Subscribe message sent, but no confirm 
received. 
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Subscription succeeded Subscribe message sent, and confirmation 
received. 

Subscription failed Failed to start filter subscription. 

Removing Sent remove message, but no confirm received. 

Removal succeeded Subscribe message sent, and confirmation 
received. 

Removal failed Failed to remove filter subscription. 

12.2 Create Caps filter 

1. Select which type of filter to create in the “Create new filter” 
dropdown-menu in the upper right of the Caps dialog.  

2. Click the Create button to create the Caps filter. 

12.3 Editing filters 

To change the properties of a filter, select the filter in the list on the left, and 
double-click the name of the property in the list on the right to change its 
value. Values marked with an asterisk (*) cannot be edited. 

For instance, to change the Update Rate of “My polygon” in the example 
above, just double-click the “Update Rate” value in the Property column in 
the list on the right. 

The name of a filter can also be changed by double-clicking the filter in the 
list on the left. 

12.4 Show In Map/Hide From Map 

These buttons are used to change whether a polygon or circle filter is 
displayed in the map or not, which is also indicated by the “Visible” 
property. Please observe that changing this property only takes effect after 
clicking the Close button. 
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12.5 Delete 

The delete button will delete the selected filter. Note that a filter with status 
Subscribing, Subscription Succeeded or Removing, cannot be deleted. The 
subscription of the filter must be removed before filter can be deleted. 


